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Que:1 Describe the use of spelling and grammar features in MS Word.

Ans: MS Word provides a feature to check spelling and grammar errors; it indicates
spelling errors with a red wavy line and grammatical errors with a green wavy line.
The newly added wavy underline in Word is blue, which indicates formatting

Spelling and Grammer Option inconsistencies.
To start checking spelling and grammar in the entire file, simply press the function

SraliinG andEramama s Enoba Grde) > ” key F7 (Spelling and Grammar Checker) or Proceed with the steps given below:

a : , i. Click on the Review tab of Ribbon.

iot In Diﬁloner!+__

'Spelling & Grammer: Ms Word providesthe ii.  Click on Spelling or Spelling and Grammer option.

feature to check the spelling of the typed text  mgrore Al | A) If spelling errors are found in the document, a dialog box appears with
and underlines the text with red line, if the — - the first mi lling found by th m heck

spcllia s Woed s wrons: o | | Addto Dictionary | e first misspelling found by the spelling checker.

Suggestions:

B) After deciding to resolve the misspelling (ignoring it, adding it to the
— =

e Change dictionary, or replacing it), the program moves on to the next
rammare Change All misspelling.
AutoCorrect
Dictionary language: | English (India} Z
[~] check grammar
Dptions... Hifds Cancel
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Page Setup Option

Page Setup ? X

Margins Paper Layout

Margins
Top: 0.57 = Bottam: 0.5 =
Left: 0.5° + | Right 0.5° o
Guttern o 5 Gutter position: Left ~
Crientation

O] =

Fortrait Landscape

Fages

Multiple pages: Maormal w~

Preview

Apply to: | This section r

Set As Default Cancel
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Que:2 Explain the use of the Page Setup option in MS Word.

Ans: Page Setup allows us to change the structure and layout of pages in a
document. The “Page Setup” group on the “Page Layout” tab contains buttons that
allow us to change the page setup of a document. We can open the “Page Setup”
dialog box by clicking on the dialog box launcher (located in the lower right corner)
in the “Page Setup” group of the “Page Layout” tab. This dialog box has three tabs:
Margins, Paper, and Layout.

Margin:

A margin is the space between the text and the edges of our document. By default,
the margins of a new document are set to Normal, which means that it has one inch
of space between the text and each edge. Based on our requirements, Word allows
us to change the size of the margins of our document.

Steps to change the Page Margins:

1. Click the Margins tab in the Page Setup dialog box.

2. Set the top, bottom, left, and right margins as needed.

3. Click OK.

Orientation:

Page orientation refers to the direction in which the document is displayed/printed.
Steps to change the Page Orientation:

1. Click the Margins tab in the Page Setup dialog box.

2. Set the page orientation to Portrait or Landscape as needed.

3. Click OK.

Page Size:

We can set the page size of our document using this option. The page size can be
LETTER SIZE, A4 and LEGAL SIZE etc. The default paper size in Microsoft Word is 8.5
x 11 inches (LETTER SIZE).

Steps to change Page Size:

1. Click the Paper tab in the Page Setup dialog box.

2. Select a page size from the drop-down list, for example: A4, Legal.

3. Click OK.
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Que:3 Explain Print Preview and Print options in MS Word.

Print Preview and Print Options

Ans: Print Preview is a feature that allows us to see how our document will look
when printed, before actually printing it. The steps to view a document using
fE  12th PracticalRecord File-Eng 2025-26 h ? 5 Print Preview are as follows:

© 1. Click on the File tab.
Erit 2. When we click on the Print (Ctrl + P) option, it automatically shows a
(n) Home = Copiess (1 © . preview of our document.
[ New vt 3. Select the printing options like Copies, Page Range, Collate etc.
Tin’ o
5 nen — Now, click on the Print button to get a hardcopy of the document.
.
Printer w o
e a==. Mitro PDF Creator V‘
e O Reaty |
Save Printer Properties
Settings
Save s »
. Print All Pages v‘
‘ The whaole thing |
Print —
™ Pages: | |'(i\‘
Share Print One Sided
‘ Only print on ane side of... i
Expart | Collated |
IED 123 123 123 V‘
Transform
‘ D Portrait Orientation -
Close
More... | D 21emx29.7 cm i g M
([ oot ol = «[o Jore2 b - i

Vikas Kansal, CF, GSSS (Girls) Sunam, Sangrur (http://cspunjab.nirmancampus.co.in/) Vikas Kansal, CF, GSSS (Girls) Sunam, Sangrur (http://cspunjab.nirmancampus.co.in/)




Page | 9 Page | 10

Formula Bar Que:4 Explain the use of Formula bar of Excel.
Ans: The Formula Bar is one of the most important components of MS Excel. The
Formula Bar is located at the top of the Excel window and just below the Ribbon

X 9~ = area. The Formula Bar has two parts, the left side shows the cell address, and the
Home Insert Page Layout Formulas Data Review View novaPD right side shows the data/formula of the currently selected cell as shown in the
= T . = figure.
=l g - = T E The formula becomes active as soon as you type the equal sign in any cell or click
PastEﬂCOpy | i s at you typ . q 9 y :
- < Format Painter = === anywhere inside the formula bar. The formula bar displays the formulas entered in
Koy CHES Eont & fignment the cell instead of the result. The formula bar can also be used to edit formulas or
L X v I~ | AL, other data entered in the active cell by clicking in the formula bar. It can also be
| B | c | b F G H used to edit the ranges of data series that are selected in an Excel chart.
1] 12 25Ij! Working with Formulas:
; Microsoft Excel is an electronic spreadsheet that automates calculations involved in
school results, grading, and student fees, etc. A formula always begins with an “="
(equal) sign. Excel can perform mathematical calculations for us.
Examples of Formulas are:
Name Box Formula in Cell =D15+D18+D21

=A10/B15

=(B16+C16)*1.07
When creating formulas, we can type cell addresses or select cell addresses using
the mouse.
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Some Commonly used functions of Excel

e e D | E
112 25 |s6  =sum(alcl)

It calculates the sum of the values from cells A1 to C1 in cell D1 and shows 93 as a result.

A B C D E
1 12 25 56 =COUNT(A1:C1)

This will count the numbers in the range A1:C1 and display the result as 3.

A B C D E
112 25 26 =MAX(AL1:C1)

This will display the largest number in the range A1:C1, i.e. 56.

A B C D E
1 12 25 56 =MIN({A1:C1)

This will display the smallest number in the range A1:C1, i.e. 12.

A B = D E
112 25 56 =AVERAGE(AL1:C1})

This will display the average value of the numbers in the range A1:C1, i.e. 31.
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Que:5 Explain some commonly used formulas in Excel.
Ans: Some common functions used in Excel:
SUM:
The SUM function in Excel returns the sum of the supplied values. The SUM
function adds up values. We can include values, cell references or ranges, or a
combination of all three.
Syntax:
=SUM (numberl, [number2], [number3], ...)

COUNT:

The COUNT function counts the number of cells that contain numbers or counts
the numbers in a list of arguments.

Syntax:

=COUNT (valuel, [valueZ], ...)

MAX:

The MAX function in Excel returns the largest numeric value in a range of values.
The MAX function ignores blank cells, logical values, true and false, and text values.
Syntax:

=MAX (numberT, [number2), ...)

MIN:

The Excel Min function returns the smallest numeric value in a range of values. The
Min function ignores blank cells, logical values, True and False, and text values.
Syntax:

=MIN (numberi, [number?2), ...)

AVERAGE:

The AVERAGE function in Excel returns the average of the values provided to the
function. The AVERAGE function can handle up to 255 different arguments, which
can include numbers, cell reference ranges, arrays, and constants.

Syntax:

=AVERAGE (numberl, [number2), ...)
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5 5[SUSHMA Malh
7 B[IATIN Math
11 10|SUKHVFER Math
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Que:6 Explain the use of Custom Filters in Excel

Ans: Sometimes our worksheets contain a lot of data, and it becomes difficult to
find the information quickly. Filters can be used to select specific data from our
worksheets, allowing us to see only the information we need.

i. Click the Data tab and then click the Filter command. A drop-down arrow will
appear in the cell above each column.

ii. Click the drop-down arrow for the column you want to filter. For example:
Subject

ii. Click on Custom Filter in the Filter menu.

iv. The Custom AutoFilter dialog box will appear.

v. Select the filter criteria and type its value (Example: Math)

vi. The data will be filtered by the selected text filter, as shown in the image.
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Output of Program

B ChUsers\Kansal\Documentshcsl.exe

Enter Marks:23

Fail

Process returned 4 (0x4)
Press any key to continue.
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Que:7 Write a program in C language that determines whether a student has
passed or failed based on the marks obtained by the student. Marks should be
entered through the keyboard.

Ans:

ffinclude<stdio.h>

void main ()

{

int marks;

printf ("Enber Marles:™);

scanf ("%d", &marks) ;
if (marks>=33)
printft ("Pass™)
else
pEIRE T T ESII™)

~4
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Que: 8 Write a program in C language to find the grade of a student which
Output of Program displays the grade of the student according to the following numbers:

e If marks >= 80 then show Grade A

e If marks >= 60 and < 80 then show Grade B

e If marks >= 40 and < 60 then show Grade C

e Otherwise show Grade D

B C\Users\Kansal\Documents\csT.exe

Enter Marks:56

Ans:
Grade C #include<stdio.h>
Process returned 7 (0x7) exec GELd AT
Press any key to continue. 1

int marks;

printf ("Enter Marks:") ;

scanf ("%d", &marks) ;
if (marks>=80)
printt ("Grade L") ;
else if (marks>=60)
PEILCE("Grade BY)
else if (marks>=40)
Printt ("Grade C");
else
printt {"Grade D™);
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Output of Program Que: 9 Write a program in C language to print the names for the days of

the week, Display the name of the day according to the day number input
by the user.

B G\Users\Kansal\Documents'csT.exe Ans:

Enter day number: 5 #include<stdio.h>

Friday void main ()
Process returned 6 (Bx6)  executir {

L

Press any key to continue. int day;

printf ("Enter day number: ");
scanf ("sd", &day) ;

switch (day)
case 1: printf ("Monday") ;break;
case Z2: printf("Tuesday") ;break;
case 3: printf ("Wednesday") ;break;
case 4: printf("Thursday") ;break;
case 5: printf("Friday") ;break;
case 6: printf("Saturday") ;break;
7 (

case /: printf("Sunday");break;
default: printf("Wrong Input");
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Que:10 Write a program in C language to display natural numbers from 1
Output of Program to n using for loop.

Ans:

#include<stdio.h>
void main ()

B ChUsers\Kansal\Documents'csT.exe

Enter number:5

{
int n,i;
printf ("Enter number:"):;
scanf ("sd", &n) ;
for(i=1;i<=n;it++)
{
5 pElnbEE M ianSd, 1)
Process returned 5 (0x5) execut: , }
Press any key to continue. }
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Que:11 Write a program in C language to display EVEN numbers from 10

Output of Program to 1 using while loop.

Ans:
#include<stdio.h>
" CA\Users\Kansah\DocumentscsT exe void main()
{
int i=10;
while (i>=1)
{
prinet (" vnsd™ 1) 3
i=i~27
Process returned 2 (0x2) - }
Press any key to continue. }
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Communication Media
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Que:12 Describe the different communication media used for networks.

Ans: The term communication media refers to the medium through which data

or information can be exchanged (communicated), such as telecommunications.

Various types of transmission media are used to transfer data. These

transmission media can be of two types:

1. Guided Media:

Guided media transmits data using cables that have a defined path. For example,

copper wires, fiber optic cables, etc.

e Twisted Pair Cable: A twisted pair cable consists of two separate insulated
copper wires that are twisted together and run parallel to each other. The
first wire is used to transfer data, and the second wire is used for grounding.
These two insulated copper wires are twisted around each other to reduce
crosstalk or electromagnetic induction between the wires.

¢ Coaxial Cable: A coaxial cable is a two-conductor electrical cable that has a
center conductor and an outer conductor, with an insulating spacer between
the two. Coaxial cables are copper cables with better insulation than twisted
pair cables, so that the transmitted signal can travel longer distances at
higher speeds.

¢ Optical fibre: An optical fibre cable consists of many optical fibres (a thin,
flexible fibre with a core of glass) that are usually covered in plastic covers or
shields. Optical cables are used to transfer digital data signals in the form of
light over distances of hundreds of miles at a higher rate than electrical
transmission cables. All optical cables use hair-like fibres made of transparent
silicon. Each fibre is made up of three layers, starting from the inner layer:

o Core which is made of high-quality silica glass or plastic.
o Cladding made of high-quality silica glass or plastic.
o External protective covering, called buffer.

2. Unguided Media:

Media that does not use any type of directed media or any guided media such

as cables etc. is called unguided media. This type of communication is also often

referred to as wireless communication. For example:

« Infrared » Radio waves
« Bluetooth » Microwaves
* Wi-Fi « Satellites
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Devices and Printers option in Control Panel Que:13 What is meant by printer sharing? How would you share a printer
over a network?

R Al cgintiol Panel fiens - | X Ans: Printer sharing is the process of allowing multiple computers and devices
4 B> Control Panel » All Control Panel [tems v | B p connected to the same network to access one or more printers. Each node or
device on the network can print to any shared printer and, to some extent, can

Adjust your computer’s settings Viewby: Largeicons T . . S .
change printer settings based on the permissions assigned to each user by the

A

administrator.

. Backup and Restore
(Windows 7)

Administrative Tools

AutoPlay If the printer is connected to a computer that supports printer sharing, the

computer can share the same printer with other computers on the same

BitLocker Drive Encryption . .
& network. It does not matter whether the shared printer is old or new.

Color Management

%

Credential Manager

& &

Date and Time Default Programs Device Manager

Sharing Printer:
& DTS Audio Control Panel i@) Ease of Access Center e Open Devices and Printers from the Control Panel
s e Right-click the printer you want to share. Click Printer Properties and then
% File Explorer Options & File History A Fonts .
select the Sharing Tab.
o Click Sharing Printer. Under Share Name, select the shared name to identify
the printer. Click OK.

[ éﬁ: Devices and Printers ]

I

Sharing Printer

« v 4 Hu » ControlPanel » All Control Panel ltems > Devices and Printers
Addadevice  Addaprinter  Seewhat'sprinting  Print server properties  Remove device
v Devices (2)

‘ = Canon LBP2900 Properties X

General Shaing Pos  Advanced Color Management Securty Device Setings Profile

DESKTOP-5RMRO Logitech® am [ you sharethis printer, only users on your network with a usemame
B U == and password for this comput t to it. The printer will not
nifying Receiver p puter can print to it. The printer will no
) be available when the computer sleeps, To change these settings,
~ Multimedia Devices (1) use the Metwork and Sharing Center,

[ Share this printer

~ SUEIETEN TS C anon LEP290C
Sachin :
%
(Gheriinipe) Render print jobs on client computers
v Printers (7)

Drivers
If this printer is shared with users running different versions of
Windows, you may want to install additional drivers, so that the
users do not have te find the print driver when they connect to the
shared printer,

Lp0a0on L0200 L
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Current Trends in Information Technology

Wi-Fi Technology

GPS Technology

b = ©
E& lﬁ' -
™
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Que:14 Explain the Current Trends in IT.

Ans: Information Technology has made unprecedented progress in the last few
years. Therefore, we need to constantly keep an eye on the emerging trends and
their implementation. The IT industry never stands still. It is a constantly changing
field, with technologies, tools, software frameworks and numerous tools and
endless ideas.

The list of current trends in Information Technology can be endless. Here, we want
to focus on just a few trends in Information Technology:

1. WIFI Technology: Wi-Fi stands for Wireless Fidelity. It is a technology that
uses radio waves for wireless high-speed internet and network
connections. Wi-Fi is a network facility through which we can connect our
computer, smartphone, laptop, or any other device to the internet without
any wire. But its coverage area is limited, we can take its benefit only within
the area range of Wi-Fi. For a Wi-Fi connection, an adapter is made into a
hotspot, which is usually a wireless router and is connected to other devices
such as laptops, mobiles, game consoles or PCs to provide internet access.

2. E-Commerce: Electronic commerce is a way of doing business over the
Internet. Under e-commerce, the buying or selling of goods or services
takes place over the Internet. In this, two or more parties exchange data or
money electronically.

3. GPS Technology: GPS stands for Global Positioning System. Today, a GPS
is available in every smartphone. GPS is used to find the geographical
location of any place. It is a global navigation satellite system. With its help,
we can find the distance or route between any two places. It is also used to
find nearby institutions, hotels, offices, etc. or to prepare maps.

4. Android Technology: Android is an operating system that is used for
mobiles. It was developed by the Open Handset Alliance and later
supported by Google. Later it started being used for touch screen devices,
cell phones and tablets. Android has proven to be a very good platform. Its
features make it better than other platforms.
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Expert System

Expert System

Output
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Que:15 What is Expert System? Explain its various components.
Ans: Expert systems are developed using the technology called artificial
intelligence, which has specialized knowledge about a specific field, subject or
skill. In fact, it is a computer program that converts the knowledge of an expert
into a software. Expert systems are developed to find solutions to complex
problems in a specific field.
An expert system is a decision-making software. It collects the knowledge of
various field experts and helps in making decisions and gives feedback with the
help of it. The knowledge that is collected from field experts is called
knowledgebase. Expert system is a good example of knowledge-based system.
Some examples of expert system are as follows-

« DENDRAL: This is an expert system for chemical analysis.

« MYCIN: This expert system specializes in the treatment of blood infections.

« CADET: This expert system is helpful in detecting early types of cancer.

« PXEDS: This is used to know the stage of lung cancer.

COMPONENT OF EXPERT SYSTEM:
The Expert System consists of the following components:

1. User Interface: It acts as an interface between the user and the inference
engine. This part receives the question from the user and then sends it to
the inference engine; after getting the result/answer, it sends the answer to
the user.

2. Inference Engine: This is the main part of the expert system. It generates
the result based on the rules and facts from its knowledge base to the user's
questions and gives an unbiased answer. It is also called the brain of the
expert system.

3. Knowledge Base: This is the part of the expert system where the knowledge
obtained from the experts is stored. The inference engine examines the data
based on the facts from the knowledge of this part and then arrives at the
result.
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Que:16 What is DigiLocker? Write the steps for using it.

DigiLocker . . .
Ans: DigilLocker is a secure way to store and manage all our important
documents online, just like NAD (National Academic Depository). Indian citizens
CITIZENS who register for this online facility are provided with a unique DigiLocker
Coa account which is linked to the Aadhaar number of the concerned individual. In
= this account, the concerned individual is provided with 1GB of cloud storage.
National Academic Depository can store only educational qualification
documents, whereas other documents like Aadhaar card, driving license etc. can
also be stored in DigiLocker.
Issues documents Accesses documents
digit=Ry online Steps for using DigiLocker:

Tﬁ'l EIQ b G‘/ — i. Open the website https://digilocker.gov.in or install the DigiLocker app
~— I

i r— from Play store on our smartphone. Now, create user ID through OTP (One

ISSUER TiuRe REQUESTOR Time Password) using Aadhaar number and Aadhaar linked mobile
number.

ii. If any of our e-documents have been issued by any organization, we can
view it in our DigiLocker. We can also upload our documents ourselves and
e-sign them.

iii.  We can share the documents by sharing the link of the documents in our
DigiLocker with others.
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Que:17 Describe the crop settings in the GIMP image editing software.
Cropping a Picture Ans: Cropping an image means removing the unwanted parts of the image from
the corners. To use this tool:

¢ Click on TOOLS — TRANSFORM TOOLS — CROP or

¢ Click on the CROP tool from the toolbox or

e Use the SHIFT+C shortcut key.
When we use this option, a box will appear on the image, with four squares
formed in its four corners. We can reduce or increase the cropping area using
these boxes. After setting the correct area, press the Enter key on the keyboard.
The image will be cropped.

Before Crop
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Que:18 Describe the rotate and flip settings in the GIMP image editing
software.

Ans: Information about rotating and flipping an image is given below:

Rotate the Image:

Rotate tool is used to rotate the image to a specific angle. To use it, click on
TOOLS — TRANSFORM TOOLS — ROTATE or click on the Rotate tool icon in the
toolbox, which will select this tool, now click on the image or use the SHIFT+R
shortcut.

To rotate the image, use the slider or we can also directly enter the value of the
angle. If we want to change the position of the image, then we can enter the
value in Center X and Center Y. Finally, click on the Rotate button.

If we want to bring the image to its original form, i.e., want to undo the changes
we have made, then click on the Reset button.

Flip the image:

Flip means changing the side of an image. This tool can flip the image vertically
or horizontally or both. To use it, click on TOOLS — TRANSFORM TOOLS — FLIP
or click on the Flip tool icon in the toolbox which will select this tool. Now click
on the image and flip it.
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Cut/Split Video Files with the Help of Free Video Cutter Joiner
L | D
F‘IL"' @ @ 00:00:00:000 / 00:00:00:000
Start Point: End Point: Duration:
Free Video Cutter Joiner X
Profile:

(®) 1 Direct Cut{No-re-encoding mode, very fast, but do not support RMVE format)

(O 2.Indrect Cut(Re-encoding mode, slow, but support all most video formats)

Video Format

|MP4 - (MPEG4 AAC) MPEG4 (*.mp4)

Video Quality Video Size
3000 kbps | [320%220
Frame Rate

same &s original file

Audio Quality Sample Rate
123 kbps | 44100 Hz
Mote: If video file have problem with No, 1 direct cut, please choica No. 2 indirect cut

Output

‘ D:y | | Erowse ‘

File Name

‘ dharam.singh ‘

Start Cut

Free Video Cutter Joiner >
Profile:

() 1.Direct Cut{No—re-encoding mode, very fast, but do not support RMVE format)

(® 2. Indirect Cut{Re-encoding mode, slow, but support all most video formats)

Video Format

MP4 - (MPEG4 AAC) MPEGA (=.mp)

i MP4 — (MPEGA AAG) MPEGA (*.mp4)
MP4 - (H264 AAC) AVC(=.mp4)
AVI - Video Format (*.avi)

FLY - Flash Video (*.flv)

MY - Windos Media Yideo (= wmv)
Framimoy - QuickTime Video (= mow)
Matrogka Video(= mice)
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Que:19 Write the steps to cut/split video files with the help of Free Video Cutter
Joiner.
Ans: The steps to cut/split video files with the help of Free Video Cutter Joiner are as
follows:
Step 1 - Adding Files: Use the Add Video File button to add files to the software.
After adding the video with the Add Video File button, the preview of the added file
can be seen inside the application.
Step 2 - Setting Start Point and End Point: Drag the button on the progress bar
to set the Start and End Point of the video and then click on the [ (Left Square
Bracket) button to set the Start Point and click on ] (Right Square Bracket) to set the
End Point of the video for splitting.
Step 3 - Cutting/Splitting the Video File: After setting the Start Point and End
Point of the file for video splitting, click on the "Cut" button. A dialog box will appear
as shown in the image, from which select the options as required. If the video file
created after cutting with the option “1. Direct Cut” is not playing properly, then use
the option “2. Indirect Cut".
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Join/Merge Video Files with the Help of Free Video Cutter Joiner

[ Free Video Cutter Joiner V10.9
Video Cutter Video Joiner

[T Source file
[ Free Video Cutter Joiner V109 — O X
Video Cutter Video Joiner how to use the software language |Englsh  ~
¥ Source file Video ... Durstion Video Sze  Frme R... Status
C:\Users\Maninder Singh\D... mp4 00:36:20.586 1920%1080 29.97fps  Ready
C:\Users\Maninder Singh\D... mp4 00:07:52.572 1920*1080 30.00fps  Ready
C:\Users\Maninder Singh\D... mp4 00:01:50.132 1920*1080 30.00fps  Ready
C:\Users\Maninder Singh\D... mp4 00:02:52.570 1920*1080 30.00fps  Ready E:J
E Join
Free Video Cutter Joiner X

Profile:
() 1.Direct Join{No-re-encoding mode, very fast, only support same-type file joining)

(8 2.Indirect Join(Re-encoding mode, very slowly, suppart any format, any type file)

Video Format
|MP4 - (MPEG4 AAC) MPEG4 (*.mp4) ~ | %

Video Quality Video Size

3000 kbps ~

320%290 >

Frame Rate

29,97 fps -
Audio Quality Sample Rate

123 kbps 44100 Hz ~

Mote: If video file have problem with No. 1 direct join, please choice Mo.2 indirect join

I

Output

= |
File Name

| Jjoined-all |

Start Join
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Que:20 Write the steps to join/merge video files with the help of Free Video Cutter
Joiner.
Ans: To join/merge videos with the help of Free Video Cutter Joiner software, first select
the Video Joiner tab by clicking on it, as shown in the image.
Step 1 - Adding or removing files: Import multiple files at once by clicking on the
Add File button. If any file is added by mistake, select that file first and then click on
the Remove button. The file will be removed.
Step 2 - Merging video files: After selecting the files to be merged, click on the
“Join" button. A dialog box will open as shown in the image, in which we can select
different settings according to our requirement. Click on the Start Join button to
join/merge the videos.

Output file settings:

By clicking on the Browse button, select the output location and then type the file name
that we want to set for the video file that will be created after merging. After merging
the videos, the file will be saved on the selected output folder/location.
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